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Presentación de CyberBoard 
CyberBoard es un sistema que facilita y hace mas agradable el juego por correspondencia o por 
correo electrónico de wargames y juegos de mesa. El programa permite recrear en el ordenador una 
visión gráfica de los componentes típicos de un juego (Tablero, Fichas y Marcadores). El jugador 
puede registrar todas sus acciones y enviarlas al Adversario para que este compruebe todos sus 
movimientos. El adversario puede en su turno revisar estas acciones (playback). Cyberboard permite 
la recreación de todo tipo de juegos de mesa, en especial los de tipo "wargame". 
 
Cyberboard no puede jugarse sin adversarios, pues no ofrece la ventaja de la inteligencia artificial. 

Descripción del Sistema 
CyberBoard reproduce Filemente los componentes del juego de mesa. La versión CyberBoard de 
cualquier juego se compone esencialmente de los siguientes componentes: un fichero "caja de juego" 
(gamebox) que contiene todos los componentes del juego, tableros, fichas, marcadores, etc.; un 
fichero "Escenario" que contiene las condiciones de comienzo de un determinado juego (tableros y 
fichas utilizadas, Posición inicial o no, etc.); y finalmente un fichero "juego" (game)que contiene la 
situación actual de un juego en curso, así como su historial de turnos. Este último fichero, crea unos 
documentos “*.mov”(move) que contienen las acciones realizadas por un jugador. Estos ficheros son 
cargados en el  “game” para ver los movimientos del contrario. 
 
En la práctica, CyberBoard se compone de dos módulos: un programa de Edición de juegos 
(CBDesign) que permite crear las Cajas de Juego, con todos sus componentes, diseñarlas desde cero, 
y un programa de juego (CBPlay) que se encarga de crear los escenarios precisos para un 
determinado juego. 
 

Características del Programa de Edición: 

• Editor gráfico bitmap para la creación de componentes, que constituirán las fichas, 
marcadores y elementos del terreno. 

• Editor a manos alzada de figuras geométricas para ayudarse en la edición de componentes.  

• Tableros y fichas en blanco de distintos tamaños. 

• Diseño de tableros con celdas modificables en tamaño y posición.  

• Posibilidad de fichas con “Doble Cara”.  

• Marcadores gráficos para señalar situaciones del juego en curso.  

• Tableros con celdas hexagonales, rectangulares y estilo muro de ladrillos.  

• Posibilidad de transparencia en los gráficos.  

• Posibilidad de colocar objetos libremente por todo el tablero. 
 



 

  Manual de Uso - CBPlay 
Pág.  4 de  26 

 
 
 

Características del Programa de Juego: 

• Editor de Escenarios para preparar los tableros, las fichas y los marcadores que se utilizarán 
en una partida.  

• Creación y Edición de pequeños ficheros de juego tipo “*.MOV” que se encargan de 
intercambiar información acerca de los turnos de juego entre adversarios. Estos archivos se 
pasan por correo y sirven para seguir el curso de la partida.  

• Juegos de Dados. Excepcionales. De 2 a 999 caras. 

• Apilamiento automático de Fichas (Auto stack).  

• Volteo de fichas con doble cara. Perfecto para juegos de Cartas.  

• Rotación de las piezas para indicar su orientación.  

• Posibilidad de ver una “traza” de los movimientos del adversario en cualquier turno. 

• Se permiten introducir todo tipo de mensajes en cualquier momento del juego.  

• Base de datos histórica de los turnos de todos los jugadores de una partida.  

Sistemas Operativos 
Windows 95, Windows 98, Windows NT Version 4.0 y Windows 2000 

Contenido de este Manual 
En este manual se describe el uso del Modulo de Juego (CBPlay), el programa de juego de 
CyberBoard. Se describe cada comando de menú, y se ejemplifica cómo poner una partida CBPlay 
en juego. El lector de esto se supone usuario habitual de Windows, y ha de entender los conceptos de 
apertura, modificación y carga de ficheros. Por lo demás no existe ninguna otra limitación a parte de 
la tecnológica para usuarios de otros sistemas operativos. 

CBPlay : Aspectos Generales 
En el modulo de juego se insertarán todos los componentes del juego. Un Escenario (Ficheros con 
extensión GSN) contienen las diferentes piezas y los tableros y marcadores que son necesarios para 
un juego determinado.  Estos componentes son creados desde el modulo de diseño CBDesign, y 
quedan registradas en un fichero "Caja de Juego" (gamebox , con extensión GBX). Para construir un 
nuevo juego o escenario hace falta siempre gamebox para que el programa reconozca los 
componentes a insertar en el nuevo archivo de preparación o GSN. 
El funcionamiento de CBDesign debe ser explicado en un manual a parte, ya que trata de la creación 
de juegos, y no del uso del sistema de juego y su modulo CBPlay. 
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El fichero de Partida (game, con extensión GAM) conserva el estado actual de una partida, así como 
un histórico de todos los movimientos efectuados.  Se pueden así realizar todo tipo de movimientos 
que podrán ser analizados en profundidad por los adversarios.. 
 
En resumen, para comunicar a los distintos jugadores, el fichero de Partida o GAM, crea una serie de 
ficheros "Movimiento" o "Turno de Juego" (game move, extensión GMV) que contienen una revisión 
histórica de los movimientos del adversario en un turno determinado. Así es posible ver los que los 
demás hacen, y permitir a estos ver lo que uno hace durante la partida. 
 
 

Escenarios 
Un escenario (Fichero de extensión GSN) contiene como ya se ha dicho todas las piezas y tableros 
necesarios para un juego, pues nosotros utilizaremos los que tenemos en la caja de juego creada 
previamente.  Debemos crear solamente los nombres de los casilleros o grupos de fichas que 
utilizaremos, tras indicar en qué gamebox nos basamos, estos grupos de fichas en Inglés Tray, sólo 
han de ser seleccionadas y preparadas conforme al uso que se les vaya a dar. 
 

 

Creación de un nuevo Escenario 
1. En el Menú File, Seleccionar New.  En el dialogo New elegir Escenario y pinchar en  

OK. 

 
2. En este momento te pedirá que indiques dónde está localizado el archivo gamebox o 

“caja de juego” (Game Box) que servirá de base al nuevo escenario.  Seleccionando el 
fichero gamebox pulsa sobre Open/Abrir. 

 
3. En estos momentos tenemos creado un fichero (Scenario Project), en el que pueden ser 

presentadas y manipuladas la mayoría de las características de un determinado juego.   
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4. Seleccionando en la pantalla principal la rúbrica “Game Scenario” y pulsando dos veces, 

aparece una ventana llamada Properties. En esta ventana Scenario Properties, reemplazar 
las informaciones que aparezcan tal y como se desee (creador de escenario, Título, 
Descripción) después cliquear en OK. 

 
 

5. Seleccionar a continuación la rubrica Playing Boards (Tableros) y cliquear Select. El 
dialogo Select Boards te permite seleccionar entre los tableros de la caja de juego, 
aquellos que se van a utilizar.  Aparece una lista de estos, y permite seleccionar uno o 
varios a la vez. Cliqueando OK aparecerán los que hemos seleccionado. 

 
 

6. Finalmente la rubrica Playing Piece Trays permite crear grupos de fichas y marcadores 
que serán utilizados en una partida determinada. Toda pieza utilizada en el juego debe ser 
reagrupada en este momento y en este fichero. Cliqueando sobre Create para crear un 
nuevo grupo o casillero de fichas. Ponerle un título de información del grupo en el 
dialogo Create Tray y cliquear OK.  
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7. En la lista se pueden ver las distintas agrupaciones de fichas, bajo el titulo Playing Piece 

Trays, y en la rubrica Playing Boards todos los tableros seleccionados. 

 
 

8. Seleccionando el nombre de una agrupación de fichas y pulsando Edit, aparece una 
ventana o dialogo llamado Setup Pieces que permite transferir las fichas de la “caja de 
juego” hasta los distintos casilelros de nuestro escenario. 

 
 

9. Cuando el escenario este completamente organizado, en el menú File seleccionar Save 
para guardar el nuevo escenario que has creado.  Pulsar Save para terminar. 
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Apertura y Modificación de un Escenario ya creado. 
1. Seleccionar el menú File-> Open.  En el dialogo Open seelccionar el tipo Scenario Files 

(*.gsn) en la lista de extensiones. 

 
 

2. Elegir vuestro escenario y pinchar en Open. Entonces se abre el Scenario Project. 

 
 

3. Modificar y añadir lo que se desee en el Escenario.  Volver a guardar vuestros 
cambios salvándolos como anteriormente se dijo. 
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Partidas 
Una vez creado el Escenario, ya estamos preparados para preparar una partida. El estado de la partida 
se conserva en el fichero de Partida, distinto al fichero de Escenario. En verdad, el fichero escenario 
sirve para colocar las fichas antes del juego, pero esto no es necesario, aunque si lo es tener el fichero 
GSN creado para poder basar en el fichero de Partida. Este tiene extensión GAM y  tanto el estado de 
la partida como el histórico de movimientos y turnos. En todo momento puedes reexaminar cualquier 
turno y ver todos sus movimientos. 

 

Creación de una nueva partida 
1. En el menú File seleccionar New. En el dialogo New elegir Game y pinchar sobre OK. 

 
 

2. Ahora debes elegir un escenario (Initial Scenario) como punto de inicio de la partida. 
Elegir el Escenario que se quiera jugar y pinchar sobre Open. (Nota : una partida no se 
puede jugar sin el fichero Escenario.) 

 
 

3. La ventana Game Project muestra las informaciones generales del fichero de juego 
(Game) : Nombre de la partida, histórico, elementos utilizados, etc. 
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4. Salvaguardar la nueva partida desde el menú File -> Save.  En el dialogo Save As, tras 

ponerle nombre hacer clic en OK. 

 

 

Abrir un fichero de Partida existente 
1. Si el fichero de partida no está abierto, hacerlo desde File -> Open.  Seleccionar la partida 

deseada y pinchar Open. 

 
2. Si la caja (gamebox) y los ficheros de partida no son los mismos (o simplemente el 

programa no los encuentra), debes buscarlos por tu disco e indicar donde se encuentran.  
Pinchar sobre OK e indicar al programa la localización de la "caja" (.gbx). 

 
3. Al abrir el fichero, la ventana Game Project será mostrada. A partir de aquí ya podemos 

utilizar todas las opciones de juego, es decir, podemos empezar a jugar. 

 



 

  Manual de Uso - CBPlay 
Pág.  11 de  26 

 
4. Para ver la situación del juego seleccionaremos el tablero que nos interese bajo la rubrica 

Playing Boards y pincharemos View. 

 
 

5. El ejemplo de juego mostrado es Drive on Metz, presentado en el capitulo 4 del libro de 
James F. Dunnigan, The Complete Wargames Handbook .  Se limitará el ejemplo a una 
partida simple de Drive on Metz. En efecto, estas reglas muestran el funcionamiento de  
CyberBoard, pero no el de un juego determinado como es Drive on Metz 
Cada juego tiene sus propias reglas de movimiento de fichas, ataques etc. 

6. En Drive on Metz, los bandos deben poner sus unidades sobre el tablero. Para hacer esto, 
seleccionar el menú View -> Tray Palette A (o B).   

 
 

7. Está permitido enviar mensajes al adversario en cualquier momento, cuando quieras 
selecciona (menú Enter Message). 
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8. Para resolver un combate, pinchar sobre el botón Roll Dice ("Juego de Dados") en el 

mismo dialogo Send Message.  El dialogo Roll Dice te permite seleccionar diferentes 
opciones (nombre de la tirada de dados, tipo, añadir modificadores).  En Drive on Metz el 
combate se resuelve con 1 dado de 6.  Pinchar en  Roll y el dado será lanzado sacando un 
resultado entre 1 et 6. Siempre se puede cambiar el numero de caras entre 2 y 999. 

 
 

9. El resultado aleatorio será mostrado en la parte superior del presente Message. Podemos 
mencionar cualquier cosa relacionada con la tirada o el combate, para que luego lo vea el 
adversario. Hacer clic en  Send & Close para salvaguardar el mensaje, y volver a la 
partida para continuar con el juego. 
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10. Después de todos los combates, tiradas y movimientos realizados por el jugador, se 

procede a salvaguardarlo todo en el archivo de "turno de juego" (game move, .gmv) y 
enviárselo al adversario.  En el menú File seleccionar Send Recorded Moves to File… 
("Enviar turno de movimientos de juego"). 

 
 
11. Nombras el fichero de movimiento o "turno de juego" en el dialogo y pinchas Save.  

 
12. Cuando pulsas Save para registrar tu "turno de juego", el programa creará un registro 

historico con tu movimiento, además del fichero para enviar al adversario. 
El Título del turno de juego sera añadido en el Histórico de la partida (Game History en 
la ventana Projet), con la fecha y la hora en que fue registrado el movimiento. La 
Descripción es una zona de texto libre para expresar comentarios.  
Pinchar sobre OK para terminar. 
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13. De vuelta a la ventana Project, puedes ver el turno de juego en la rubrica Game History. 

 
 

14. Los ficheros “MOV” se envían por cualquier método, normalmente adjuntándolos a 
mensajes de correo, foros, etc.  

15. Bien!  El turno del adversario y ha sido descargado a tu ordenador. Veamos que contiene. 
Abrir el fichero de partida y en el menú File seleccionar Load Recorded Move 
File("cargar fichero 'turno de juego'"). 

 
 
16. El dialogo te pedirá el nombre del fichero turno de juego. Seleccionar el que convenga y 

pinchar Open. 
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17. La ventana Game Project muestra el turno de juego que nos envía nuestro adversario en 
la rubrica Histórica, con la fecha y la hora, su titulo y la descripción con éste lo haya 
dotado. 

 
18. En el menú Playback seleccionar Next Move para adentrarte en la secuencia de juego del 

adversario.  
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19. Para moverse a través del turno del adversario, utilizar  el menú Playback o los iconos 

con aspecto de controles de video que aparecen en la barra de herramientas.  Nota : Next 
Move se activa con la tecla F3. 

 
20. Después de haber visto todo el turno del contrario.  En el menú Playback seleccionar 

Accept Move File Playback ("aceptar el fichero turno de juego"). 

 
 

21. Salvaguardar el fichero de partida, y pasar a la ejecución de tu propio turno de juego 
como ya se ha descrito. Moviendo las fichas, realizando acciones, combates, etc, y luego 
guardando en “MOV” y enviándoselo al contrario. 
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REFERENCIAS 

Ventana Escenario(Scenario Project) 
Al cargar un escenario se pueden encontrar muchos botones que cumplen funciones idénticas a las de 
los comandos de menú que ya han sido mencionados. 
 
La lista de contenido de un escenario muestra las siguientes rubricas : 

Game Scenario 
Comprende la información disponible acerca del contenido del juego:   
 

Properties – Ficha donde se añade la información del escenario. 
 

 

Playing Boards 
Esta rubrica determina qué tableros está presentes en el escenario de juego. Los botones de comando 
que presenta son los siguientes: 
 

Select – Muestra el dialogo de selección de tableros. 
 

 

Nombres de los Tableros disponibles 
Esta lista muestra los que ya han sido seleccionados. Sus botones son : 

View – Muestra la vista gráfica del tablero (Playing Board).  
Properties – Muestra el dialogo de información del tablero llamado Board Properties. 
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Remove – Borra un tablero seleccionado. 

 

Playing Piece Trays 
Las fichas de juego son agrupadas en casilleros como se dijo antes, para separar los distintos bandos, 
por ejemplo: 

Create – Muestra es dialogo crear casilla de fichas (Create Tray). 

 

Nombres de casilleros o grupos disponibles 
La lista muestra los casilleros o agrupaciones de fichas creados previamente : 

Edit – Muestra el dialogo Selección de fichas. Estas fichas ya fueron creadas en el Fichero 
“caja de juego” con CBDesign, como ya se ha explicado. 

Properties – Muestra las propiedades del grupo o casillero de fichas. 
Delete – Elimina un grupo previamente seleccionado (después de un mensaje de 
confirmación). 
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Ventana de Partida (Game Project) 
Al cargar un escenario se pueden encontrar muchos botones que cumplen funciones idénticas a las de 
los comandos de menú que ya han sido mencionados. 
 
La lista de contenido de una partida muestra las siguientes rubricas: 
 

Game 
Información general acerca de la Partida. No tiene ningún botón. 
 

 

Playing Boards 
Muestra la lista de tableros adjuntados a la partida. 
 

 

Nombres de Tableros 
Lista de tableros en juego. Sus botones son los siguientes : 

View – Muestra el tablero gráficamente.  
 Properties – Muestra el diálogo Board Properties del tablero seleccionado. 



 

  Manual de Uso - CBPlay 
Pág.  20 de  26 

 

 

Game History 
Guarda el histórico de la partida. Sus botones de comando son los siguientes: 

Load – Para seleccionar un fichero "turno de juego" a cargar y activar. Después de la carga, 
el programa se pone en modo (playback) y se pueden visionar la acciones de ese turno en 
concreto. 

 

<Move File Playback>Nombre del  turno de juego 
Se muestra si un fichero "turno de juego" a sido Cargado pero No Registrado en el fichero de partida. 
Sus botones son los siguientes : 

Accept – Para ACEPTAR el turno de juego y Registrarlo como aceptado en el fichero de 
partida.  
 Discard – Para rehusar el turno de juego y eliminar el fichero "turno de juego". 

 

<Current Recording> 
Esta rubrica aparece cuanto estamos moviéndonos por un turno de juego o cuando estamos moviendo 
y aún no hemos guardado nada en un fichero "turno de juego". Sus botones son : 
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Save – Registra las acciones realizadas en un fichero "turno de juego" a enviar al adversario.  

 Discard – Para descartar todas las acciones memorizadas. 

 

[Date] [Time] – Nombre de un  turno de juego 
Presenta la cronología histórica de los distintos turnos de una partida en curso. Sus botones son : 

Replay – Para volver al turno anterior al cargado.  
 Export – Para salvaguardar en otro "turno de juego" (.gmv). 

 

<History Entry Playback> 
Aparece cuando se está visionando un turno de juego. Sus botones son los siguientes : 

Done – Finaliza el modo de revisión (playback).  
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Comandos de Menús 

File Menu 
New… [Nuevo] Ctrl+N 

Open… [Abrir] Ctrl+O 
Close [Cerrar] 

Save [Guardar] Ctrl+S 
Save As… [Guardar como..] 
Recent Files Opened [Ficheros Recientes] 

Exit [Salir] Ctrl+F4 

Edit Menu 
Copy Board Image to Clipboard [Copiar imagen al portapapeles] 

Como el portapapeles de Windows.  Ctrl+C 
Save Board Image in File… [Guardar una imagen del tablero] 

Delete Markers [Quitar marcadores seleccionados] 
Tecla Delete después de seleccionarlos. 

Select All Markers [Seleccionar todos los marcadores] 
Permite seleccionar todos los marcadores de un tablero 

Select All Markers From [Seleccionar todos los marcadores de...] 
Un dialogo permite especificar en que tablero serán seleccionados. 

Board Properties… [Características de tablero] 

View Menu 
Main Toolbar 

Muestra u oculta la barra de herramientas. 
Status Bar 

Muestra la barra de estado. 
Snap Grid 

Muestra las celdas del tablero . 
Tray Palette A 

Muestra las fichas del grupo A . 
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Tray Palette B 

Muestra las fichas del grupo B . 
Marker Palette 

Muestra el grupo de marcadores. 
Full Scale Board 

Visualizar un tablero en modo normal. 
Half Scale Board 

Visualizar un tablero en modo vista reducida. 
Hide Pieces 

Oculta momentáneamente las fichas y marcadores del tablero. Vale F9 
Indicators on Top 

Hace que todas las fichas y marcadores vuelvan a su estado normal.  Vale 
F10 

Project Menu 
(Visible solamente en el fichero Escenario) 
Create Playing Piece Tray 

Dialogo de creación de casillero de fichas. 
Create Trays from Piece Groups 

Dialogo para seleccionar las fichas desde un grupo.  
Seelct Game Boards 

Seleccionar Tableros. 
Seelct Game Pieces 

Seleccionar Fichas . 
Scenario Properties 

Información del escenario. 
 

Actions 
Auto Stack 

Apila las fichas y /  o marcadores que se hayan seleccionado en un 
montoncito. Vale  Ctrl+A. 

Move to Front 
Envía una ficha seleccionada al frente. Para ponerla sobre otra. Vale Ctrl+F 

Move to Back 
Envía una ficha seleccionada al fondo. Para ponerla bajo otra. Vale Ctrl+B 

Turn Piece Over 
Permite dar vuelta a una ficha de “Dos caras”. Vale Ctrl+I 
 



 

  Manual de Uso - CBPlay 
Pág.  24 de  26 

 
Rotate Piece – Incremental 

Dialogo de Rotación de Piezas.  Se puede girar 5, 10, o 50 grados, en los dos 
sentidos. 

Rotate Piece – Absolute 
Abre un dialogo de rotación  mas complicado pero efectivo para cierto juegos 
de guerra: 
Reset Rotation – Deshacer rotación. 
Square Faces – Ángulos: 0, 90, 180, y 270 grados. 
Hex Faces (Flat Up) – Ángulos: 60, 120, 240, y 300 grados. 
Hex Faces (Point Up) – Ángulos:  30, 150, 210, y 330 grados. 
Diamond Faces– Ángulos: 45, 135, 225, y 315 grados. 

Begin a Compound Move 
(visible solamente en un fichero de partida .GAM) 
Comenzar a registrar un movimiento. Vale Ctrl+Enter 

Accept a Compound Move 
(visible solamente en un fichero de partida .GAM) 
Terminada la revisión de un movimiento, hay que aceptarlo. Vale Enter 

Discard a Compound Move 
(visible solamente en un fichero de partida .GAM) 
Abandonar los movimientos. Vale Esc 

Roll Dice 
(visible solamente en un fichero de partida .GAM) 
Abre el dialogo para tirar dados (Roll Dice). Vale Ctrl+R 

Enter Message 
(visible solamente en un fichero de partida .GAM) 
Abre el dialogo de Message . Vale Ctrl+M 

Playback Menu 
(visible solamente en un fichero de partida .GAM) 

Start of Moves 
Volver al primer movimiento de un turno "turno de juego". Vale F2 

Next Move 
Avanzar por los movimientos.  Vale F3 

Previous Move 
Movimiento anterior.  Vale F4 

End of Moves 
Finalizar los movimientos. Ir al final. Vale F5 

Singel Step Compound Moves 
Para tipo de movimiento paso a paso.  
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Next History Entry 

Siguiente turno Histórico. 
Close History Playback 

Terminar revisión.  
Accept Move File Playback… 

Aceptar y registrar el movimiento cargado. 
Discard Move File Playback 

Descartar los movimientos que has visto. 
Show Current Message 

Mostrar mensajes del fichero.  

Window Menu 
Manual Windows. 

Help Menu 
Manual de ayuda en Windows. 
 
 

El motivo de esta traducción es impedir que se reduzca el acceso a esta 
herramienta mediante métodos socioeconómicos poco afines a la 
naturaleza del  juego en comunidad. Si alguien se siente ofendido o 
contrariado por la traducción. Contacte con el traductor de la versión 
española aquí 

mailto:gambarcp@hotmail.com
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Botones de la barra de herramientas 

 
 
 

De izquierda a derecha, si posamos el ratón sobre los iconos, aparecerán los siguientes títulos: 
 

Nuevo… Partida o Escenario 
Abrir… Partida o Escenario 
Guardar… Partida o Escenario 
Enviar registro en un fichero (Send Recording to File) 
Cargar fichero turno de juego (Load Recorded Move File) 
-  -  -  - 
Principio de movimientos (F2) 
Movimiento anterior (F4) 
Movimiento siguiente (F3) 
Fin de los Movimientos (F5) 
Abrir Turno de juego siguiente en el Histórico (F6) 
Terminar la visión histórica 
- - - - - 
Cambiar la visión de las piezas. Ocultar o no. 
- - - - - 
Casillero de Fichas A 
Casillero de Fichas B 
Casillero de Marcadores 
- - - - - 
Comenzar movimiento compuesto (Ctrl+Enter) 
Terminar movimiento compuesto (Enter) 
Anular movimiento compuesto (Esc) 
NOTA: Este tipo de movimiento es usado opcionalmente. 
- - - - - 
Escribir un mensaje (Ctrl+M) 
Sacar los dados (Ctrl+R)  
- - - - - 
Enviar arriba una ficha (Ctrl+F) 
Enviar al fondo una ficha (Ctrl+B) 
Apilamiento automático (Ctrl+A) 
Rehacer la pieza (Ctrl+I) 
- - - - - 
Mostrar u ocultar las celdas del tablero. 
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